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ARLSOFT
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FOR WINDOWS

What PhotoStudio Can Do For You

Whether you are interested in multimedia, graphic
design, desktop publishing, or video editing,
PhotoStudio can be the canvas of your imagination.

PhotoStudio 2.0 is a powerful and easy-to-use 32-bit
digital photo image editing program running on
computers with Microsoft Windows 25, 98 and NT.

It gives you the ability to acquire, manage and
output full-color images for publications,
presentations, or animations. And whether you are a
novice or a professional graphic artist, you can use
PhotoStudio for a broad range of image
manipulations and refinements. The only limit is your
creativity.




ArcSoft PhotoStudio Software License Agreement

The following is a legal software license agreement between you, the software end user, and ArcSoft, Inc. Carefully read this
license agreement before using the product. Using the product indicates that you have read this license agreement and agree
to its terms

Grant of License. This license permits you to use one copy of the software included in this package on any single computer. For
each software licensee, the program can be "in use’ on only one computer at any given time. The software is 'in use" when it is
either loaded into RAM or installed into the hard disk or other permanent memory. A special license permit from ArcSoft is
required if the program is going to be installed on a network server for the sole purpose of distribution to other computers.

Copyright. The software conlained in this package is owned by ArcSoft and is protected by United States copyright laws,
international treaty provisions, and all other applicable naticnal laws. The software must be treated like all other copyrighted
materials (e.g. books and musical recordings). This license does not allow the software to be rented or leased, and the written
materials accompanying the software (if any) may not be copied.

Limited Warranty. ArcSoft, Inc., warrants that the software contained herein wilt perform substantially in accardance with the
accompanying documentation,

No Other Warranties. ArcSoft disclaims all other warranties, either express or implied, including but not limited to implied
warranties of merchantability and fitness for a particular purpose, with respect to the Software, the accompanying written
materials, and any accompanying hardware (if any)

No Liability for Consequential Damages. In no event shall ArcSoft or its suppliers be liable for any damages whatsoever
(including but not limited to damages for loss of business profits, business interruption, loss of business information, or any other
pecuniary loss) which results from an inability to use this software, even if ArcSoft, inc. has been advised of the possibility of
such damages Because some states/jurisdictions do not allow the exclusion or limitation of consequentiaf or incidental
damages, the above limitations may not apply to you.

U.S. Government Restricted Rights. The Software and documentation are provided with Restricted Rights. Use, duplication, or
disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data
and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1).(2), and (3) of the Commercial Computer
Software - Restricted Rights at 48 CFR 52,227-19, as applicable, and any amendments thereto. The manufacturer is ArcSoft,
Inc., 46601 Fremont Blvd, Fremont, CA 94538.

If this product was purchased in the United States, this Agreement is governed by the laws of the state of California; otherwise,
local laws may apply.
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Chapter 1: Introduction
What PhotoStudio Can Do For You

Whether you are interested in multimedia, graphic
design, desktop publishing, or video editing,
PhotoStudio can be the canvas of your imagination.

PhotoStudio 2.0 is a powerful and easy-to-use 32-bit
digital photo image editing program running on

computers with Microsoft Windows 95, NT and 3.1x. It

gives you the ability to acquire, manage and output
full-color images for publications, presentations, or
animations. And whether you are a novice or a
professional graphic artist, you can use PhotoStudio
for a broad range of image manipulations and
refinements. The only limit is your creativity.

The following is an overview of some of the features
provided in PhotoStudio.

With PhotoStudio you can:
Work with many different types of images from
many different sources

« Fully integrated with Ricoh digital cameras for
easily and quickly downloading and uploading
photos.

o Acquire images from any digital cameras,
scanners or other image input devices that
support the TWAIN industry standard.

* Import black-and-white line art (1-bit), color (4-,
8-, or 24-bit), or grayscale images (8-bit) into
PhotoStudio or export PhotoStudio images to
other applications. PhotoStudio supports
most popular image file formats, such as BMP,
GIF, PCD, PCX, TGA, TIFF, and JPEG.
PhotoStudio also supports third party Adobe
Photoshop Plug-Ins for import and export.

e Exchange images with other Windows
applications (like Microsoft Word, CorelDraw,
PageMaker, and PC PaintBrush) through the
Windows clipboard.

e Perform data format conversions between 1-bit
Black-and-White, 4- and 8-bit Indexed Color, 24-
bit RGB True Color, and 8-bit Grayscale images.

Customize your working environment and image

view

* Organize your images in convenient working
groups using the Aloum Manager.

* Display your images on-screen in timed
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presentation sequences.
¢ Show, hide, and position rulers and palettes.
* View many images simultaneously.
* View images at different magnification ratios.

Create, retouch or paint images with a wide variety
of customizable tools

* Draw and paint on the image using tools like the
Pen, Paintbrush, and Airbrush Tools.
¢ Add labels, captions, or titles with the Text Tool,

*  Seamiessly duplicate part of an image in a
different area of the image (or even in another
image) using the Clone Tool.

*  Selectively alter your image using the Smudge,
Smooth/Sharpen, Brighten/Darken, and Revert
Tools.

Select or mask parts of your image for editing

s Use four different selecting tools to select any
part of your image.

e Edit the existing mask, and move it to anywhere
you wish.

e Import a mask into an image, or export and save
it for future use.

Edit and compose images with full control of

options

* Copy and paste selected areas within an image
or between different images.

e Fill selected areas with colors, gradients, or
predefined patterns.

* Resize, rotate, flip, shift, and skew an image or
selected area.

Perform sophisticated image enhancements and
color corrections

¢ Fine-tune the brightness and contrast or adjust
the shadows, midtones, or highlights of an image.

e Alter the Color/Gray mapping curves to transform
image colors.

*  Modify hue and saturation to correct color shifts
created by image input devices.

¢ Improve image guality with a variety of smooth
and sharpen filters.

¢ Simulate photographic processes with filters like

Solarization, etc.

=
=
=
=
=
=
1
=
=
| =
=
=
=
=2
=3




Apply many special effect filters

* (Create special effects with the trace contour, oil
painting, sketch, film grain, splash, melting,
ripple, wrinkle, 30 grid, mosaic, motion blur,
emboss, fish-eye, cone, sphere, cylinder,
whirlpool, spiral, or ribbon filter.

e Design your own special filters or create infinite 2-

D and 3-D special effects by using the powerful
User's Filter or Magic Mirror.

¢ Support third party Adobe Photoshop Plug-In
filters for special effects.

Output and send your image quickly and easily

*  Print your image in any size and anywhere on a
selected paper.

* Send an image e-mail message right from
PhotoStudio with just one click.

Get complete and comprehensive on-line help

s (all up simple, relevant help information with one
keystroke when you have guestions.

Chapter Two

Getting Started

There are two ways to run PhotoStudio:
1. From the Program Manager:

Double-click on the PhotoStudio icon in the
PhotoStudio group window. A PhotoStudio logo
image will appear in the center of your screen.

Click your mouse anywhere inside the image area
to dismiss the logo image.

2. From within PhotoBase:

Double-click on any thumbnail image in an album
and PhotoStudio will automatically launch.

The PhotoStudio Application Window

When you are working with PhotoStudio, your screen
will look something like the illustration below. The
default PhotoStudio screen is a maximized window,
consisting of a Client Area, a Menu Bar, a Title Bar, a
Status Line and a Tools Palette. The Client Area
displays the image(s) you are working on. The Menu
Bar contains a list of menu titles (i.e. File, Edit, eic)
and is located below the Title Bar. You may modify or
enhance your images by using funcions in Tools
Palette, or selecting options from the "pull-down
menus" using the mouse or the keyboard.

The PhotoStudio screen also contains certain
Windows features such as the Control lcon, buttons to
minimize, maximize, or restore image windows. For
more information on these features, consult your
Windows User's Manual.

In the following, we will give a brief description for
some elements in the PhotoStudio screen. You will
find a detailed discussion for the Status Line and the
Tools Palette in the other sections in this chapter
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The Floating Palettes

In addition to the floating Tools Palette, a floating
Brush Palette and a floating Color Palette may appear
on the PhotoStudio screen. "Floating" palettes can be
moved to any location on the screen.

The Tools Palette contains tools for image editing; the
Brush Palette is used to define the size, shape, and
drawing speed (spacing) of the editing tools; and the
Color Palette is used for quick color selecting. You
can show or hide these palettes by using the
appropriate commands from the View menu.

Image Windows

When you open an image file or scan in an image, it
appears in the Client Area inside its own window — an
image window. Each image window has its own Title
Bar which displays the filename of an image. You can
expand a window by grabbing its frame with the
pointer and dragging it outward. If you want the
window to fill the entire Client Area, click the Control
Icon in the upper left-hand corner and choose
"Maximize”. You can also minimize a window by
selecting "Minimize". Image windows can also be
moved to a new location on the screen. To close a
window, select "Close" from its Control Icon menu.

You can open more than one window at once so that
you can transfer data from one image 1o ancther very
easily. However, only one image window can be active
at one time. The active one is always in front of the
others and its title bar is highlighted. To activate an
iImage window, simply click the mouse on its Title Bar.

The Status Line

The Status Line at the bottorn of the screen is divided
into four sections for displaying a variety of
information. From this line, you can get the view ratio,
processing percentage, pixel color value, data type,
and size information of the active image. You can aiso
get pointer coordinates, system information and hints
on how to use tools.
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Pull-Down Menus

A Pull-Down Menu consists of a listing of options or
"selections”. You may select from these options using
the mouse or the keyboard. Depending on the current
state of the image, certain selections within a meny
may not be accessed. These selections are
differentiated from the selections that are available by
a lighter font.

Submenus

An arrow which appears with a menu item indicates
that it has a "submenu". To access a submenu, simply
select the menu item, continue holding down the
mouse button, and move the mouse pointer over to
the submenu to select the submenu item you want.

New.. - 1
Qpen... C+0

Close CtrlsFA
Seve CtrleS
Save As...

Album Manager...
Presentation...

Capture.

Acquire Yo ~
Exit Cuteq L_Printer Setup..

1. CAWINDOWSIRIVETS.BMP
2. CAWINDOWSIHONEY.BMP
3. CAWINDOWSIDGT.BMP

4. CAWINDOWSICASTI F.BMP

Dialog Boxes and Features

A dialog box appears after you choose menu
commands that contain an ellipsis (a series of three
periods, like the one in "Open..." in the File menu).
Commands which are not followed by an ellipsis
perform an action immediately (e.g., "Cut" in the Edit
menu).

The following is a description of certain dialog box

features which you

Editing box Command buttons
Dialog box

List box

Drop down list box

will use the most.

List Boxes

Many dialog boxes contain "List Boxes" which allow
you to select the filename, drive or directory you wish
to access.

Drop-Down List Boxes
Drop-down list boxes consist of a box which displays
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the current selection inside a rectangular box. If you
want to make a different selection, simply click the
downward-facing arrow to reveal a list of available
options. Drag the cursor to the selection of your
choice and release the mouse button.

Editing Boxes

Editing boxes are rectangular boxes which are either
empty or contain a default option. If an editing box is
blank, you need to enter text or value information by
inserting the cursor and typing.

Buttons

There are several types of button used in windows.
The radio and check buttons allow you to select one
of various options. The push buttons allow you to
close a dialog box, save changes, cancel changes or
execute other commands.

Scroll Bars

Many dialog boxes have scroll bars which allow you
to access additional options. You may scroll up,
down, left, and right by clicking the respective arrows.
As you click the arrow, a flashing box moves in the
direction you are scrolling to show you its relative
position.

Display Boxes

There are some dialog boxes that have a display box
which is a graphic representation of the information in
the dialog box. You may alter the curve inside the
display box by clicking and dragging, and changes
will accordingly occur on the preview image indexed
by "After".

Preview Windows

There are some dialog boxes that contain preview
windows with thumbnail images for previewing the
result of the operation. As socon as you alter any
parameter in the dialog box, you can see the change
in the window indexed by "After". As a reference, a
sample image representing the active image without
any change is shown in the "Before" window. Click the
*‘OK" button until you are satisfied with the change in
the "After” window.

Option buttons

Preview

windows Display box
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The PhotoStudio Menus

This section summarizes functions in each
PhotoStudio menu. For more details about the
commands in a menu, refer to the on-fine help.

File

The File menu contains a number of commands which
allow you to manage and manipulate image document
files. There are the standard New, Open, Close, Save,
Save As, and Print commands found in many other
types of programs. You can aiso use this menu to
acquire images, make slide presentations on the
computer screen, restore your image to its last saved
condition, or capture images from the desktop.
Choosing a file name from the file list at the bottom of
the menu will open that file directly.

Edit

The Edit menu contains commands for modifying your
images. With this menu you can control selections by
cutting them out, copying them to the clipboard, or
importing them from the clipboard. You can also
adjust selected areas by filling them with colors,
patterns, blends, swapping them with the underlying
areas, making them appear raised from the image, or
turning them into image documents. in addition to
these functions, you can also use the Stitch command
to merge two or more images into one.

Mask
The Mask menu contains commands for creating
selections as well as modifying existing masks.

Transform

The Transform menu contains functions for changing
the size, resalution, orientation, and shape of images
and selections. Commands include: Resample, Flip

Vertically (Horizontally), Mirror, Repeat, Rotate, Shift,
and Resize.

Enhance

The Enhance menu provides you with a full line of
very advanced yet easy to use functions for
manipulating your images. Commands like Brightness
and Contrast, Hue and Saturation, and Tone
Adjustment are the best tools for color correction. A
variety of Smoothing and Sharpening filters are
provided to enhance the quality of images. Many
other filters are also available for special use.

Effects
The Effect menu contains many filters that allows you
to apply novel special effects to your images. For
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example, you can convert your images into artistic
renderings like oil paintings or pencil sketches. You
can also make your image look embossed or as if it is
made of tiles. You will find it really entertaining if you
try to go through the Effects menu and see how each
effect changes an image.

Convert

The Convert menu provides you with commands that
change the data type of an image. For an example,
you can convert a 24-bit image to an 8-bit index color
image, a 4-bit index color image, an 8-bit grayscale
image, or a 1-bit black-and-white image.

View

The commands in the View menu manage the
PhotoStudio work space and the image display, as
well as give information about the image. You can
manage the work space by showing or hiding various
palettes (e.g., the Tools Palette), and the ruiers. You
can change the view of an image with the Zoom In or
Zoom Out commands. You can also use this menu to
adjust the gamma values of the monitor.

Windows

The Windows menu contains commands for
managing the document windows in PhotoStudio. You
can choose whether you want image windows to be
piled one on top of the other or if you want them toc be
packed next to each other and fully visible. There is
also a command that lets you close all of the windows
at the same time. At the bottom of the window menu,
there is a list of all the windows for the image
documents opened on the desktop. Choosing a name
will make that the active image window.

Help

The Help menu gives you an index of the general help
topics available in the PhotoStudio on-line help. You
can choose to look at the general help index, or at the
help indexes for keyboard comrands, menu
commands, procedures, or tools and palettes. You
can also look at a dialog box that gives some basic
information about PhotoStudio.

The PhotoStudio Tools

PhotoStudio provides four selection tools, eight
accessory tools, and twelve painting and retouching
tools. The Tools are located along the far right-hand
edge of the screen when PhotoStudio starts. By
dragging the Tools Palette title bar, you can move the
Tools Palette to wherever you like. And you can hide
the Tools Palette by double-clicking on its title bar
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To select a tool, simply click it with the mouse. When
you double-click on some of the tools, an options
dialog box will appear so that you can alter the tool's
characteristics.

Rectangle Select Ellipse Select
Freehand Select Magic Wand Select
Mask Move Area Move
Zoom Grabber
Text - Stamp
Gradient Fill — — Bucket Fill
Airbrush —- Paintbrush
Smudge - ——- : - Pen
Brighten/Darken . ‘ — Smooth/Sharpen
Clone - — Revert
Transform --— — [EEEBVE - Crop
Eyedropper - —- - - Trash Can

Color Swatches

Rectangle Select Tool-Selects rectangular-shaped
area.

Ellipse Select Tool-Selects elliptical- or oval-shaped
area.

Freehand Select Tool-Selects an irregularly-shaped
or polygonal area.

Magic Wand Tool-Selects a contiguous area based
on color similarity.

Mask Move Tool-Moves the current mask to a
different part of image without moving inside portion.

Area Move Tool-Moves baoth the mask and the pixels
that lie within its boundaries.

Zoom Tool-Magnifies your view of an image.

Grabber Tool-Adjusts the position of an image which
is larger than the image window.
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Text Tool-Enters a line of text on an image document.

Stamp Tool-Stamps a predefined shape on an image
with every click and drag of your mouse.

Gradient Fill Tool-Fills a selected area or entire
image with colors which are gradually mixed together
from the alternative to the active color.

Bucket Fill Tool-Fills the active color on a contiguous
area based on the color similarity.

Airbrush Tool-Spray the active color onto an image
like an airbrush.

Paintbrush Tool-Paint the active color on an image
like a paint-brush.

Smudge Tool-Smears the "paint” in an image,
blending neighboring colors together.

Pen Tool-Applies paint to create a hard-edged effect,
like a marker or felt-tip pen.

Brighten/Darken Tool-Lightens or darkens an area
by increasing or decreasing the pixels.

Smooth/Sharpen Tool-Smooths an image by
decreasing contrast or clarifies an image by
maximizing the contrast between pixels.

Clone Tool-Copies part of an image to another area
within the same image or between images or paints
with a pattern contained in the clipboard.

Revert Tool-Blends the changes had made to the
currently masked area together with the original
underlying image.

Transform Tool-Resizes, rotates, skews, or distorts
the current selection.

Crop Tool-Creates a new image window for the
selected area.

Eyedropper Tool-Shows the image color values
under the pointer, and changes the active color to a
color that is selected on the image.

Trash Can Tool-Removes the selected image and
the mask.

Color Swatches-Displays the current active and
alternative colors.

Using the Status Line for Information

The status line often provides information to you that
can make your current task easier. There are four
areas in the status line, and each one will show
different information depending on what you're doing.
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The following table shows you the different states of
the status line:

Current Left Status  Left Center  Right Center  Right Area
Activity Line Area Area Area
no image  blank " blank " blank " free memory
available
image " blank blank % of file read " "Press Esc
opening completed to abort”
processing - viewing ratio ' image size % processing "Préss Esc
and type completed to abort"
click on tool” viewing ratio ' image size " tool name " description
of button and type tool purpose
foalinusé " viewing ratio | image size current mouse  déscription
and type * location of use of
‘ current tool
eyedropper | viewing ratio; image size  mause “useand
and type coordinates color values
of current
! location

| )

Note that the image size is a figure that is dependent
on the image dimensions, data type and resolution,
regardless of actual image file format. This should not
be confused with the image’s file size; file sizes can
vary widely based on the efficiency and compression
(if any) of the file format.

The viewing ratio shows you how much your current
view of the image has been magnified or reduced.
See the Zoom Tool reference information for help on
viewing ratios.

Using the Keyboard

Rather than moving the pointer to a menu every time
you wish to use a command, try these keystrokes.
Using them will shorten the time it takes to initiate a
command

Menu Command Keys:

Key(s) Command F2 Resample

Ctrl+O  Open F3 Brightness and
Ctri+F4  Close Contrast

Ctri+S  Save Fa Hue and

Ctrl+P  Print Saturation

Cirl+Q  Exit F5 Tone Adjustment
Ctri+Z  Undo/Redo Ctri+R  Show/Hide Rulers
Ctrl+X  Cut Ctrl+W  Full Screen
Ctrl+C  Copy Ctri+T  Show/Hide Tools
Ctrl+V  Paste Ctrl+L  Show/Hide Color
Del Clear Palette

Ctri+F  Fill Ctrl+B  Show/Hide Brush
Ctrl+A Al Palette

Ctri+ Invert F1 Index/PhotoStudio
Ctrl+N  None Help




You can use the keyboard for fast access to some of
the most frequently used PhotoStudio menu
commands. For more information on these
commands, see the appropriate reference section.

ESCAPE KEY:
The escape Key is important in some situations.
Situation Function

Processing Cancels time consuming operations

Presenting Interrupts Presentation and restores
desktop

Full Screen lerminates Full Screen mode and returns
1o deskiop

Dialog box Exits dialog box like clicking the Cancel
button

HELP KEY:

Typing the F1 key will give you different types of help
depending on what you are doing in PhotoStudio.

Situation Help Screen

Dialog box is open Help window for that dialog box will
appear

Help window for that command

Help for the current Help window will
appear

PhotoStudio help index will appear

Menu command lit
Help window appears

Any other time

SCROLLING KEYS:
If the scroll bar is visible, you can use the scrolling
keys to scroll an image window.

Key(s) Function

Up Arrow Image will scroll upwards

Down Arrow Image will scroll downwards
Left Arrow Image will scroll left

Right Arrow Image will scroll right

Page Up Image will scroll up one page
Page Down Image will scroll down one page

Ctri+Page Up
Ctrl+Page Down

Image will scroli left one page
Image will scroll right one page

OTHER SHORTCUTS:
Action(s) Situation

Shift + Left

Button Down Selecting tool in use

Function

Add the new selection to the
existing mask when you
drag the mouse

Presentation active Reduces the current slide

view

Full screen active Reduces the current image
view

Zoam tool setected Reduces the current image
view

Clone tool selected Seiects Clone source,
showing sign (+)
Selects the active color
Selects the active color
Selects the active color
Selects the active color

Selects the active color

Text tool selected
Stamp tool selected
Gradient Fill selected
Bucket Fill selected
Airbrush tool selected
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Paintbrush tool selected
Pen tool selected

Selects the active color
Selects the active celor
Ctrl + Left

Button Down Pointer in the area Ready to move the selected
arca like the Arca Move tool
Ctrl + Arrow  Active image on focus
down, left, or right
according to the arrow Ctrl

+"+"3ign  Active image on focus Zooms in the active image
one step

Ctrl + "-" SignActive image on focus Zooms out the active image
one slep

Using the Context-Sensitive On-line Help
System

PhotoStudio makes the most of the Windows help
system that you have probably seen in other Windows
programs. In addition, it provides you with context-
sensitive help thal can be invcked at any time by
pressing the F1 function key (located at the upper left
of most keyboards).

To use the help system in the standard Windows
manner, simply choose your topic from the Help menu
at the right side of the menu bar. A help window
containing PhotoStudio’s help information on that
general topic will appear, and you can proceed from
this help page to the specific lopic you want by
clicking on the subtopics that interest you. Clicking on
the Search button will call up a list of general
PhotoStudio terms and topics. You can also get help
on the help system itself. For more information on
using the Windows help system, see your Windows
manual.

To use the context-sensitive help, get to the dialog
box or menu item you are curicus about and then
press the F1 key. For example, if you want to see the
help on the Resample menu command, pulf down the
Transform menu, highlight the Resample command
without releasing the mouse button, and press F1
(while stilf holding the mouse button down). The help
window will appear, with the information on the
Resample command already displayed! This helps
you to get directly to the topic you want without
having to search through the help topics and
subtopics.

For dialog boxes, simply press F1 when the dialog
box you are inlerested in is on the screen. You can
also get help on tools by double-clicking on the tool
button to call up the tool's settings dialog box and
then pressing F1. (If the tool does not have a settings
dialog box, however, double-clicking will have no

Moves the selected area up.
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effect, You won't be able to use the context-sensitive
help feature for that tool.)

Pressing F1 when you are already in help will call up
the “How to Use Help" topic.

Correcting Mistakes

There are many ways to correct mistakes while editing
your image. If you take precautions, you'll be able to
achieve the effect you want without ever taking a risk
of losing all your previous work. Here are the
recommended ways to correct mistakes:

1) Always keep a backup copy of important images,
and update your backup when you have made
significant progress on the criginal. This is good
practice in general, of course, and it is also
recommended that you make frequent backups of
your entire hard disk to avoid losing your work.

To make a backup, simply copy the image file to
another name. For example, to back up
PEACOCK.TIF, copy the image to PEACOCK.BAK (for
backup). in DOS, you would do this by typing “COPY
PEACOCK.TIF PEACOCK.BAK".

2) Use the Undo command. This is the first menu
item under the Edit menu, and it's your first line of
defense against mistakes. Undo reverses the last
action you made, so if you catch yourself quickly after
a mistake, it can be a lifesaver.

However, Undo cannot correct something you did
several actions ago. If you sharpen a part of your
image and then add some new color, Undo will not be
able to unsharpen for you. If you Undo, it will take
away the new color. {f you Undo again, it will add the
new color back again, because it is undoing your
undo.

Also, there are some actions that Undo cannot
reverse. For example, if you save a document, Undo
cannot undo that save, because your computer has
already changed the information in the image file and
those changes have been written on your hard disk.
When you cannot undo, the Undo menu item is
grayed out in the Edit menu.

3) Use the Restore command. This File menu
command restores the current image from your disk
It's the same as closing the image without saving your
changes and opening the original image.

Of course, there are times when this is not appropriate
either. If you've just saved your file accidentally after
having made some mistakes, restoring will not get you
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back to where you were before the mistakes occcurred.
And if you saved your file ten minutes ago, made
some very desirable changes, and then made some
grievous mistakes, restoring will eliminate both the
mistakes and the desirable changes.

4) Cancel undesirable processes before they finish.
You can press the Esc key to cancel some processes.
If this is an option, you'll see “Press Esc to abort” in
the status line at the bottom right. Of course, you can
undo if the process finishes, but pressing Esc will
save you some time.

5) Mask your image before trying anything risky. If
you mask your image (or part of your image) before
experimenting, you can use the Revert Tool and Trash
Can Tool to salvage the image if things go wrong.
Note that the Trash Can Tool and Revert Tool will only
affect changes made after the mask was drawn. If you
make a mistake and then mask it, they will not affect
the mistake.

6) Try the Trash Can Tool. If you mask your work area
before making changes, you can discard your
mistakes (and the mask) merely by clicking on the
Trash Can Tool.

The Trash Can Tool can be used effectively in a “two
steps forward, one step back” method. Mask your
image and experiment. If you like it, remove the mask
using the None command from the Mask menu (don't
use the Trash Can Tool or else you'll lose your
changes). Removing the mask makes those changes
immune to the Trash Can Tool, because the tool only
affects changes made to the current mask. Then
mask again and experiment; if the experiment fails,
use the Trash Can Tool.

This method has several advantages over Undo and
Restore. With masking, you can make several
changes before you choose 1o accept or reject them.
With the Undo command, you have to make your
decision immediately. Also, the masking method is
quick. If you use the Restore command to fix mistakes
all the time, you'll spend a ot of time waiting for your
image to be saved and loaded over and over again.
(However, it's a good idea to save your image
periodically.)

7) Blend the new and the old with the Revert Tool. If
you want a compromise between the current selection
and the image as it was before you made the
selection, try using the Revert Tool. It works like a
paintbrush that paints the local area with a mix of your




current selection and the underlying image. You can
change the percentages of the images so you get
more of one and less of the other

This is especially useful when you made some
desirable changes in one area of your selection and
some mistakes in another. If this is the case with you,
simply set the Revert Tool to its maximum revert effect
and drag the mouse over the mistakes.

For more information, see the Revert Tool reference
section.

Some Tips
This section will give you some hints on saving time
and working efficiently with PhotoStudio.

Minimize the area that PhotoStudio must redraw
Every time you make an edit, PhotoStudio has to
redraw the image. By selecting a small part of the
image, you can decrease the size of the section that
is redrawn, because PhotoStudio only reformulates
the selected area. You can also try reducing the size
of the image window so only the area you are editing
appears in it.

If you are only working on a small part of the picture,
make sure that area is masked. Not only will you
speed up PhotoStudio, you will also protect the parts
of the picture that you do not want to change.

Even if you are working with the entire image, try
editing a small part of the image first. Once you are
sure of the edits you want to make, you can go back
and modify the entire image. This is an especially
helpful technique when you are applying complex
effects or filters which take a long time for PhotoStudio
to perform.

Keep your computer’s memory uncluttered. To free
up memory, close the images you are not working
with.

Close any windows that you do not need. Having a
window open will take up memory space. This will
decrease the amount of available memory that
PhotoStudio has to perform tasks on your active
window.

Clear the Clipboard image or replace it with a smaller
one if you will not use it any more. Images kept on
the Clipboard will also take up space and slow down
PhotoStudio.

If you are only working with one channel, separate
your image into Grayscale images. Modify the
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Grayscale image that represents this channel, and
then combine all three Grayscale images to reform the
original. This will decrease the time it takes
PhotoStudio to calculate edits.

Use two windows instead of one.

After you open an image document, open a second
identical window for the document, using the
Duplicate command, and place the matching
documents side by side. This will allow you to check
whether your edits have produced the intended effect.
Also, when you zoom in on your picture to make pixel
by pixel edits, you will not need to zoom out again to
see the big picture.

If the painting tools do not work, you may be
drawing outside of the select area.

Even if you can not see a marquee, there may be a
select area that is too small to see, or it may be in part
of your image that is not currently on screen.

To eliminate the possibility that there may be a select
area, pick None from the Mask menu, or type Ctrl + N.
After you do this the paint tools should begin to work
correctly.

Working in a selected area will give you the most
mistake correction options and minimize painting
mistakes.

If you are not working inside a select area, you will not
be able to use the Revert or Trash Can Tools. These
tools are valuable options when you make a mistake
or change your mind.

Drawing a marquee around an area where you plan to
use a painting or drawing tool will protect the rest of
the document. This is important because painting and
drawing errors can be hard to correct.

Exiting PhotoStudio

You can either douhle-click the control menu icon of
the PhotoStudio window or choose the "Exit’
command from the File menu to exit from PhotoStudio.

If the application window contains any image windows
with unsaved changes, a dialog box will appear to
verify if you want to save that image before exiting
PhotoStudio. Clicking "Yes" will save the image;
clicking "No" will close the image without saving it;
clicking "Cancel" will cancel the Exit command.




Chapter 3
Working With PhotoStudio and Ricoh Cameras

This chapter describes some basic concepts and
concerns when working with PhotoStudio, and Ricoh
digital cameras.

Working with Colors

Defining colors in PhotoStudio

It is important to understand the concept of color
when working with PhotoStudio. This, after all, is an
image color processor. It allows you to change, shift,
or enhance colors in your image document and select
items in your document based on their color similarity.

To describe color, we have to consider how the eye
perceives color, and how colors are created. When
you perceive color, it is really your brain reacting to
the wavelengths of light that reach your eye.

If all wavelengths of light reach your eye, you
perceive the white color. If there is no light, you
perceive black. If some but not all wavelengths of
light reach your eye, you will perceive a particular
color. So then by mixing light in different ways we can
create virtually every color.

This is how your computer monitor works. By mixing
three basic colors (red, green, and blue) in varying
amounts, it can create over millions of different colors.

This is the origin of the RGB model for describing
color. This mode! uses three color channels: red (R),
green (G), and blue (B). Every pixel in the image is a
mixture of these three channels.

Each one of these color channels can have a value
anywhere from O to 255. The value for a color channel
describes the intensity of that color. A value of 0
means that channel has no intensity and wiil have no
effect on a pixel's color, and a value of 255 means
that it is at full intensity. So, a pixel with the channel
values R = 0, G = 255, and B = 0, will appear as light
green; a pixel with the channel values R = 150, G = 0,
and B = 150 will be purple, since purple is the result
of mixing of red and blue.

There is another popular model for describing colors:
the HSV model. Instead of three color channels, the
HSY model describes colors with channels for hue
(H), saturation (S), and brightness (V).

Hue describes colors based on a special color wheel
containing all of the colors of the spectrum, and can
have values from 0 to 360. Values for Hue determine
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the location (in degrees) where a color is at on the
color wheel. All millions of the possible colors can be
somewhere on the wheel.

Saturation describes the intensity of the color and can
be any number from O (very gray) to 255 (very colorful).

Brightness describes the lightness/darkness of the
color and has values from O (black) to 255 (white).

Many people find the HSV model to be more intuitive
and therefore easier to work with. Professionals in the
graphics and photography industries often prefer to
work with HSV because these industries often use this
color models. You should try both and see which
works best for you.

Active and alternative color swatches

At the bottom of the Tools Palette, you will see two
caolor squares, one lying on top of the other. The color
swatch on top is the active color swatch. The toois
and commands that utilize color (e.g., Bucket Fill,
Paintbrush, Cut) will always use this color as their
source. The color on the bottom is the alternative or
alternate color. These two colors are both used by
the Gradient Fill Tool.

Sometimes you will want to quickly toggle between
two colors without having to continually pick colors
from the Color Palette or elsewhere. |t is very easy to
switch the active and alternate colors—ijust click on
the alternate color.

Changing the color of the active swatch

In PhotoStudio, there are three ways to select a new
color. First, you can simply pick a color from the
Color Palette by clicking on any colored square. If the
Color Palette is not visible, use the Show Color Palette
command from the View menu and it will appear on
the desktop.

Another way to change the color is to use the
Eyedropper tool; click on any color in the image with
this toal and the active color swatch will become the
same color.

Finally, you can use the Color Selection dialog box to
pick a new active colar. This method gives you the
widest range of possible colors. To make this dialog
box appear, double-click on the active color swaich.

To change the alternative color double-click the
alternate swatch.

(See "Color Swatches” in Chapter 4 for detail on using
the Color Selection dialog box).




Making color-based selections
You can use the Magic Wand Tool to create selection
areas based on color Similarity or Threshold.

When you set the values for Similarity, you are telling
the Magic Wand how close to the color of the
selected pixel the other pixels in the selection area
should be. The smaller the similarity value, the smaller
the area of selaction will likely be.

For example, if you click the Magic Wand on a pixel
which has the RGB channe! values 50 for red, 60 for
green, and 70 for blue, and you set the similarity to 5
for each of the channels, the magic wand will select
only those pixels which have red values that are
between 45 and 55, green between 55 and 65, and
blue between 65 and 75. Increasing the similarity
values will make the above intervals larger.

The Threshold option is simpler than this. It picks all of
the nearby colors that are in the same threshold
category as the selected color. So if your threshold
value is 150 and the color value is 130, the wand will
pick all adjacent colors with values less than 150.

(See "Magic Wand Too!" in Chapter 4 for more
information).

image Data Types and Conversions

This section describes the image data types and their
conversions that used in PhotoStudio. The data type
of an image is important because it determines how
many colors (or gray levels) the image may contain
and how the image can be manipulated in
PhotoStudio.

About Image Data Types

PhotoStudio can read and create five different image
data types: 24-bit RGB True Color, 4-bit Indexed 16-
Color, 8-bit Indexed 256-Color, 8-bit Grayscale, and
1-bit Black-and-White. PhotoStudic is able to easily
convert most data types into others.

There are a coupie of general differences between the
data types worth mentioning up front.

The number of bits per pixel differs for the data types.
This number determines the number of colors or
shades that can be represented in the image. The
more bits per pixel, the more memory is necessary for
the image, the more information the image file will
contain, and the more realistic it will seem.

Many PhotoStudio commands and tools do not work
on certain image types. For example, many of the

Enhance and Effects commands will not work with
1-bit Black-and-White and Indexed-Color images.

In general, when you want to edit images you should
make sure they are either RGB True Color or
Grayscale images, because most PhotoStudio
functions are available when editing these two data
types. You can always change them to another form
after you finish editing.

1-Bit Black-and-White Images

Pixels in 1-bit Black-and-White images are either
black (0) or white (1). This type of image uses only
one channel and takes the least memory.

Several editing commands do not work with this type
of image. In fact, none of the effects commands and
only one of the enhance commands can be used with
the Black-and-White image type. Some tools and
other commands are off-limits as well.

If you wish to edit a Black-and-White image. try
converting it to an 8-bit Grayscale image first. When
you are done editing you can change it back to 1-bit
Black-and-White.

If an image is going to be printed or used on a device
that has only black-and-white capabilities, you may
want to convert it to this data type to get an idea of
how it will look. Of course, images saved in this data
type use much less memory than the others.

Black-and-White images can also be used to create
masks and stamps. For more information, see the
reference sections on the Mask menu and the Stamp
tool.

8-Bit Grayscale Images

Grayscale is a single-channel data type. Pixels can
have gray values from O to 255; the lower the value,
the darker the pixel. Grayscale images have full
editing capabilities.

Grayscale data type is the best form for editing
images with no color.

Indexed 16- and 256-Color Images

Indexed 16-Color (4-bit) and 256-Color (8-bit) images
are single-channel image documents. All of the colors
in indexed color images are in the color table, a
special palette that can have either 16 (4-bit) or 256
(8-bit) colors. When an indexed-color image is
created in PhotoStudio, the program picks the most
appropriate colors and makes a color table that will
give the best representation of the original. Indexed
images can be edited in a limited number of ways,

FAARARARARARARPESARNARARNAARNASR




but they also take up less disk space and less space
in memory.

None of the filters or the effects commands work for
indexed-color images. Also, some of the tools also
will not work for this image data type.

Some computer systems can only display 16 or 256
colors. Converting an image to indexed-color is a
good way to preview what an image will look like on
devices that support a limited amount of colors. If an
RGB True Color image will be displayed on such a
system, it may be better to convert this image to an
indexed-color image, because you can control the
way that the system approximates the images’ colors.
Keep in mind, though, that even when the system can
not show all of the available colors, PhotoStudio can
stilt store them in the image file.

24-Bit RGB True Color Images

RGB True Color image data type contains the
maximum amount of information possible for an
image. and allows you to choose from over 16 million
different colors. This data type uses three channels:
red, green, and blue. Each channel can have values
from 0 (no color) to 255 (full color). Any PhotoStudio
command or too! will work with the RGB True Color
images.

image type conversion options

Often you will want to convert an image from one data
type to another. When you do so, there are several
options that you should understand.

Colors and color palette options

When you convert an RGB True Color image to
Indexed-Color image, you will often need to pick a
color or a color palette option. There are the major
conversion options you may see in PhotoStudic
conversion commands:

System and Optimized are frequently options for the
color palette. The System option will use the Windows
system palette found in the Windows' Control Panel.
An Optimized color palette creates a color palette by
sampling the image for the most used colors.

The 666 and 676 System are two predefined color
palettes for 256 color image. The 676-created palette
will contain six reds, seven greens, six blues, and
combinations of these colors, while 666 will use six of
each color channel and their mixtures.

When you convert a Grayscale image into an Indexed
256-Color image, you will need to pick from two
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options: Firelight and Pseudo Color. Firelight will
convert the Grayscale image into an image that looks
as if it is lit by firelight. Its color table will contain
shades of red, yellow, and orange. Similarly, Pseudo
Color will create a color table from shades of blue,
green, yellow, red, white, and black.

Note: Some image data types can not be converted
into other data types. If a particular type of
transformation is not available for an image, the menu
item in the Convert menu will be dimmed.

Dithering options

Converting images to Indexed 16- and 256-Color or
Black-and-White images will often create harsh color
changes and eliminate many of the contours in your
document. Dithering is a way of smoothing out these
harsh color changes. Essentially, dithering simulates
shades of caolor or grayness with combinations of
pixels. For example, when converting from Grayscale
to Black-and-White by using dithering, a square of
four pixels that has an average grayness value of 128
would become a square with two black pixels and two
white pixels.

There are two main dithering options: Pattern and
Diffusion.

A Pattern dither replaces squares of pixels in the
image with squares that have representative
configurations of pixels in the allowable colors.

A Diffusion dither converts one pixel at a time but
transfers the error, or difference, between the original
value of the pixel and the new value to nearby pixels.
In other words, it “diffuses” the error throughout the
picture. This will make the picture look somewhat
grainy.

Acquiring, Importing, and Exporting Iimages
There are several ways to bring images into
PhotoStudio, and ta export them out for use by other
programs

You can open exisling image files of various types by
using the Open command, or use the Clipboard and
Capture commands to get images from the Windows
Clipboard and/or other Windows applications. You
can load images dircctly from a digital camera. And
you can also use a scanner or other image input
device to acquire images from a slide, photo print,
artwork hard copy, or video. After being processed,
images can then be saved in one of the formats
provided in PhotoStudio and then transferred to other




applications and system platforms.

Acquiring

Besides fully supparting the Ricoh RDC-1, RDC-2,
and RDC-4000 digital cameras for acquiring images,
PhotoStudio can directly interface with and control a
digital camera, image scanner, or other input device
that supports the TWAIN standard. By installing the
device driver provided by the manufacturer and
selecting this device from the Select Source dialog
box, you give PhotoStudio the capability to recognize
and receive images from your TWAIN-compatible
device.

Although the options for acquiring an image are
varied for different digital cameras and scanners,
selecting a proper resolution to acquire may be the
most important choice. For scanning, for example, the
higher the resolution selected, the better the printing
image quality obtained. However, this is not always
true. The printing quality is also determined by the
capability of your printer. And be aware that a higher-
resolution image requires more memory to work with
and to store. If the image is just used for screen
display, the resolution may not need to be greater
than that of the monitor screen, which is typically from
about 70 to 130 dots per inch (dpi).

To get images from a TWAIN device, select Acquire in
the File menu. For more information, see the on-line
help references for Acquire and Select Source
commands.

Importing and exporting images—about file format
PhotoStudio allows you to open and save image
documents in many file formats. A file format is the
way that the information in an image is stored o a
computer file. There are several standards that
different computer devices and programs use to store
image information. The file formats supported by
PhotoStudio represent the most popular formats in
use today and will allow you to transfer image
information between PhotoStudio and virtually any
other program that you will want to use.

Some file formats may compress files or give you the
option of compressing your files. There are basically
two different types of compression: lossy and lossless.
Using a lossless compression algorithm such as LZW
compression to save your image usually makes the
saved file smaller without any information loss. Using
a lossy compression may bring you a higher
compression ratio, but it will lose some image

information. JPEG compression is a good example of
lossy compression.

The JPEG format is an excellent way to store final
images if you want to save disk space while storing
virtually all of the information that uncompressed
images have. You can vary the compression ratio
depending on how much image information you can
sacrifice. The better quality compressed image you
want, the less compression you can get.

If you plan to edit an image later, it is not suggested
to store your image in a lossy compressed file format,
because some small amount of information may be
lost each time you save the image. Over the course of
many recompressions this may add up to the loss of a
lot of information. Also, compression and
decompression takes time, and may be burdensome
on a slow computer.

To open or save an image document, select Open or
Save As command from the File menu, and a dialog
box with options for file format will appear. The
different fite formats supported in PhotoStudio include
BMP, GIF, PCD, PCX, TARGA, TIFF, and JPEG. And
more file formats will be added in PhotoStudio.

BMP is the bitmapped file format that is widely used
in Microsoft Windows and its applications. A
bitmapped file uses a Windows Device independent
Bitmap (DIB) to store the data. These files specify
pixel color in a form that is independent of the way
that a device represents color. These files generally
have the filename extension “.bmp”.

TIFF is the Tagged Image File Format. This format
works well for transferring images between different
computers and is widely used in the printing industry.
These files are stored as “ tif".

GIF is the Graphics Interchange Format developed by
Compuserve. This is an excellent format to use for
transferring files between different types of computers
or over phone lines, because it can minimize transfer
time. This format can support up to 8-hit resolution.
24-Bit RGB True Color images cannot be stored in this
format. These files are labeled “.gif".

PCD is the Photo-CD format developed by Kodak.
Images in this format are usually compressed in a
compact disc and have several different resolutions
avallable. This format is mainly designed for desktop
publishing image transform and can be read (but not
saved) in PhotoStudio. Photo-CD files are labeled “pcd”.
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PCX is a standard format used by many IBM PC
programs. it was specifically designed by ZSoft for its
PC Paintbrush program. Files in this format are
labeled “.pex™.

TARGA is a format developed by TrueVision, a maker
of video boards. This format is used by several
painting and image enhancement programs. Its files
are stored as “.tga".

JPEG is an often-used compression format. This is an
excellent format to use when you have finished editing
a picture and wish to store it in a highly-compressed
form. Using JPEG compression may result in the loss
of a smail part of your image information. JPEG files
generally have the extension “.jpg".

Selecting and Masking Images

About Masks, Marquees, and Selected Areas

The concept of selecting objects in an image is, along
with the concept of defining colors, one of the most
important ideas in image processing. After all, if you
are not using the program tc enhance the color and
picture quality of your entire image, then you are
probably using it to move or change particular areas.

Tasks like changing the color of the sky, making
dramatic silhouettes, or rearranging people in a
portrait are all possible with PhotoStudio, but first, you
must be able to select these objects. In this section,
we only discuss some basic concepts of selecting.

New Terms
The concept of picking objects or areas centers
around several basic terms.

The selected area is the part of the image that is
surrounded by the marquee. The marquee is the
dashed moving line that designates the selected area.
The selected area is the only part of the image where
your edits will have any effect. If there is no selected
area, any edits will have effect on the entire image.
The term selection is synonymous with selected area.

The mask is another name for the marquee. You can
move the mask around in an image to define an
infinite number of selection areas. These areas will
have the same shape as the mask.

So we see that a mask is a shape, and a selection is
a piece of an image.

What You Can Do
There are several powerful selecting tools and
commands in PhotoStudio. We will not try to

enumerate all of them here; that task is left for the
reference part of Tool and Command. Here, we merely
wish to hint at some of the fun and interesting things
that you can do with the selecting tocls and
commands.

You can create selections of any shape by using the
selecting tools.

You can make a selection based on the color of an
area. For example, if you want to change the color of
the sky from blue to red, the magic wand tool can
select the sky with just one click.

You can copy a selection from your image onto the
clipboard, and then paste it on other PhotoStudio
images or on other applications.

Again, these are not all of the things you can do with
the selecting and masking functions, but hopefuily
they will give you an inkling of what you can do with
PhotoStudic. For more information on making
selections, please refer to "Rectangle Select Tool",
"Ellipse Select Tocl", "Freehand Select Tool", and
"Magic Wand Tool" in Chapter 4, and the on-line help
for the Mask menu.

Working with Adobe Photoshop Plug-In
Filters

PhotoStudio supports Photoshop Plug-In filters for
image import, export and special effects. When
started, PhotoStudio will first search all the *.8ba (for
import), *.8be (for export), and *.8bf (for effects) files
in its PLUGINS subdirectory, and then the directories
that are shown in the entry of the PluginDir1,
PluginDir2, and 3 etc. in the PSTUDIO.INI file that is
located in the Windows directory. If any these type of
files installed in the PLUGINS directory or identified in
the path entry in the PSTUDIO.INI file, the Import,
Export, and Plug-In Filters submenu will appear in the
File and Effects menu respectively, and the filters are
listed.

For example, if you have Kai's Power Tool special
effects filters installed in both of the C\KPT and
CKPT1 directories and you want PhotoStudio
support them, you shall add the following lines in the
CAWINDOWS\PSTUDIO.INI file:

PluginDir1=C:\KPT PluginDir2=C:\KPT1

Including the PLUGINS subdirectory, PhotoStudio
supports up to five directories that contain plug-in
filters.




Chapter 4
Reference for Palettes and Tools

By using the commands in the View menu, you can
have three floating palettes—the Tools Palette, the
Color Palette, and the Brush Palette—simultaneously
displayed on the screen.

The Color Palette contains a variety of predefined
colors for quick color selecting. The Brush Palette is
used to define the size, shape, and drawing speed of
the editing tools. The Tools Palette contains twenty-
four tools and two color swatches for image editing

This chapter describes the three floating palettes and
the tools in the Tools Palette.

Color Palette

The Color Palette

The Color Palette shows a good sample of the colors
you can choose for the active color in PhotoStudio. To
call it up, choose the Show Color Palette command
from the View menu.

As you move the mouse over the palette, the mouse
pointer changes to the Eyedropper Tool's pointer, and
the status bar will display the RGB (or HSV) color
values of the color that's under the pointer. When you
find a color you like, simply click on it to make it the
active color.

Of course, the palette’s colors change depending on
the type of image you are working on. If it is a 24-bit
RGB True Color image, the palette will show a
sampling of the millions of colors you can use. If it is
8-bit Grayscale, it will show all 256 gray levels; if it is
16- ar 256-Color Indexed, it will show all colors in the
image's color lookup table; and if it is 1-bit Black-and-
White, the palette will display both black and white

You can move the palette by clicking on its blue title
bar and dragging. To put the palette away, either
double-click on its title bar or choose Hide Color
Palette from the View menu. If the palette is displayed
when you quit PhotoStudio, it will reappear when you
start the program again.

The Brush Palette

The Brush Palette gives you control
over the shape of the brush that is used
by many of PhotoStudio's major painting
and retouching tools. To activate it,
choose the Show Brush Palette
command from the View menu.

(2]

Mt [42]
s B2
2 Re

3]
g|a

The Size setting changes the brush
size, which is measured in pixels. The
Speed setting alters the rate at which
the tools add their effects when you are
moving the mouse. For example, at
higher Speed settings, the Paintbrush
Tool will draw a solid line when the
mouse is dragged quickly. At lower
settings, the rate will be slower and you
will be able to create gaps in the line by
dragging quickly.
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You can type in a value for Size and Speed, or use
the up and down arrows. The top six buttons allow
you to pick various brush shapes that have variable
sizes. The large button at the bottom is the user
editable brush. If you double click on this button, the
User Defined Brush dialog box will appear to let you
edit your own brush shape.

The User-Defined Brush dialog box shows you a grid
which corresponds to the shape of the brush you are
defining. Black squares on the grid are active, and
will affect the image when the brush is used. White
squares are not active. Click on a square to change
its status; press and drag in the grid to change many
squares.

You can change the size of your brush by changing
the grid size. The largest size is 32 pixels by 32
pixels. ( Although the size of the grid in the dialog box
does not actually change, the density of the square
changes. Since each square is equivalent to a pixel,
more square means that the brush will affect a larger
area.)

You can also save brush shapes and load them back
later when you want to use them. Brush shapes are
saved with a “.bsh” filename extension.

PhotoStudio remembers the brush shape and size
settings when you quit and restores them, or when
you run the program again.

You can movc the palette by clicking on its blue title
bar and dragging. To put the palette away, either
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double-click on its title bar or choose
Hide Brush Palette from the View
menu. If the palette is displayed when
you quit PhotoStudio, it will reappear
when you start the program again.

The Tools Palette and Tools

The Tools Palette contains tools for
selecting, viewing, drawing, painting,
retouching, and editing images. It also
contains controls for choosing the
active and alternative colors.

When you move the mouse over its
icon in the Tools Palette, a brief
description of the tool will appear in
the main window's status line. To
select a tool, click on its icon.

Most tools are affected by the setting
on the Brush Palette and color in the
active color swatch when you are
painting/editing an image. Some tools
have specific options associated with
them. To access tool options, double-
click on the icon of a tool. In the rest
part of this chapter, we will describe
all tools in the order from the top to the
bottom of the Tools Palette

Rectangle Select Tool

This tool allows you to select rectangular
portions of your image. To use it, simply press
and drag in the image window. As long as you hold
the mouse button down, you can change the size of
the selection you are making. Release the mouse
button when you have selected the portion you want.
The pointer position and the size of the selected
rectangle are displayed in the status line (located at
bottom of the PhotoStudio window) during the
selecting operation.

If you decide you want to remove the mask you have
created, click (but do not drag) anywhere in the
image, or choose None from the Mask menu.

You can also combine the existing mask with your
new selection by holding down the Shift key and
dragging.

Tip: To make accurate selections, make sure the
mouse pointer is at one corner of the rectangular area
you want to select before you start to click and drag.
If the options are set to Draw From Center, you will
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want to make sure the pointer js at the center of the
area you want to select. (See "Options” below.)

= Rectangle Select Option

OfSauare f
[J Draw From Center
[ size Fixed

width:[ | Pixels
Height[ | Pixels

When you double-click on the Rectangle Select Tool
button, a dialog box will appear for more options.
Click OK to activate your setting. Options in the
Rectangle Select Tool dialog box:

Square - When this box is checked, the tool will
always select perfectly square areas of your image. If
you try to select a rectangular area, the tool will limit
the size of the selection to the largest possible square
within that rectangular area.

Draw From Center — Allows you to draw rectangular
selections out from the center of the area you want to
select. When this option is on, simply click at the
center of the area you want to select and then drag
the mouse out toward any corner of the area.

Size Fixed —- When this option is turned on, the tool
will only select areas of the fixed size you specify in
the width and height fields. If you turn the Square
option on as well, PhotoStudio will require the width
and height fields to be equal. Simply click on the
location on the image, a desired selection will appear.
(:} This tool allows you to select elliptical or oval-

shaped portions of your image. To use it,
simply press and drag in the image window. As long
as you hold the mouse button down, you can change
the size and shape of the selection you are making.
Release the mouse button when you have selected
the portion you want. The pointer position and the size
of the selected area are displayed in the status line

(located at bottom of the PhotoStudio window) during
the selecting operation.

Ellipse Select Tool

If you decide you want to remove the existing
selection, click (but do not drag) anywhere in the
image.




You can also combine the existing mask with your
new selection by holding down the Shift key and
dragging.

Tip: For morc accurate selections, imagine that you
are using the rectangle select tool to make a
rectangular selection that is just the right size to
contain the oval area you want. Make sure the mouse
pointer is at one corner of that imaginary rectangular
area before you start to click and drag. Also, you may
want to try the Draw From Center option. (See
“Options” below.)

When you double-click on the Eilipse Select Tool
button, a dialog box will appear for more options.
Click OK to activate your setting.

Options in the Ellipse Select Tool dialog box:
Circle — When this box is checked, the tool will always
select perfectly circular areas of your image. If you try
to select an elliptical area, the tool will limit the size of
the selection to the largest possibie circle within that
area.

Draw From Center - Allows you to draw elliptical
selections out from the center of the area you want to
select. When this option is on, simply click at the
center of the area you want to select and then drag
the mouse outwards.

Size Fixed - When this option is turned on, the tool
will anly select areas of the fixed size you specify in
the width and height fields. If you turn the Circle
option on as well, PhotoStudio will require the width
and height fields to be equal.

Freehand/Polygon Select Tool

To create irregularly-shaped or polygonal

selections, you should use this tool. You can
also make selections that are partly polygonal and
partly irregular.

Irregular selections are made by pressing and
dragging in the image window. Simply move the
mouse around the area you want to select. If you want
a polygonal selection—like a star or an octagon—you
only need to click the mouse on the points of the
polygon, in a connect-the-dots fashion. PhotoStudio
will connect the points where you click. (Note: The
Stamp Tool has a template feature that makes some
polygonal selections easier.)

By using a combination of these two techniques, you
can create a selection that is partly polygonal and
partly irregular.
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You can also combine the existing mask with your
new selection by holding down the Shift key and
dragging

When you are ready to finish your selection, double-

click on the point where you want to end the selection.

Most people find it easiest to simply make the
selection and then double-click on the place where
they started, thus making a complete shape. If you do
not double-click where you started, PhotoStudio will
complete the selection with straight lines.

This tool has no options, so double-clicking on the
too!l button has no effect.

wegad The Magic Wand Tool is very handy for
situations where you want to select an area of
your image based on color similarity. (in
grayscale and black-and-white images, it selects
regions of similar darkness.) For example, if your
image is a landscape with a blue sky, you can use the
magic wand tool to select the sky without selecting
the white clouds at the same time. Then you can
apply various effects to change the color of the sky

To make this selection, you would just click on the sky
with the magic wand tool. The tool selects everything
of that color or a similar color. The tool also has an
option that allows you only to select a contiguous area
of your image based on color similarity. In other
words, it will select all of the blue in the sky, but it
won't select the blue ball that's in the middle of the
meadow.

Of course, it's not always that easy, since there are
parts of the sky that are lighter than others, and you
may end up just selecting part of the sky. Also, if your
image also includes a blue lake that touches the sky,
you may end up selecting the sky and the lake.

However, you can change the tool's sensitivity by
adjusting the options. Also, the tool can add to the
current selection when the Shift key is held down.

When you double-click on the Magic Wand Tool
button, a dialog box will appear for mare options.
Click OK to activate your setting.

Options in the Magic Wand Tool dialog box:
Contiguous Area Only - If this box is checked, the
magic wand tool only selects the contiguous area
containing the pixel you click on. Otherwise, the tool
selects all pixels in the image that have the same or
similar color to the pixel where you clicked on.

Similarity - This is the default setting for this tool.
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When this is the setting, the Magic Wand selects the
color you click on and all colors that are (1) touching
the clicked-on color and (2) are similar to the clicked-
on color. The similarity sensitivity is specified by the
RGB sliding settings; the higher the numbers, the
greater the number of colors that will be selected.

Threshold — When set to Threshold, the Magic Wand
Tool categorizes all the pixels in your image into two
types: ones that have RGB values that are all greater
than the threshold settings, and others that have
values equal to or below them. (A pixe! with red and
green values greater than the respective threshold
settings but a blue value below the threshold blue
value would fall into the “less than" category.) Then
when you click in your image, the tool selects the
calor you click on and all colors that are (1) touching
the clicked-on color and (2) are in the same threshold
category as the first color.

RGB Sliders — There are three sliders; one each for
red, green, and blue. Each one has a range of O to
255, which corresponds to the color values given to
each color in a PhotoStudio image.

swsey Mask Move Tool
184 The Mask Move Tool gives you the power to
move the current mask to a different part of
your image. When you click in the current selection
and drag, the tool picks up the mask—without
changing its shape, but ieaving the currently-masked
pixels behind-—and relocates it in your image window.
in its new position, the mask acts just like any
ordinary mask, and any pixels within its borders will
be affected by commands or tocls that you use.

This tool has no effect if you don’t have anything
selected in your image window. It has no options, so
double-clicking on its tocl button in the toolbox has no
effect. Masks cannot be moved between images with
this tool.
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Area Move Tool
Unlike the mask move tool, the area move tool

moves both the mask and the pixels that lie
within its boundaries. To use it, click in the current
mask and drag it to its new location.

The tool does not remove the original masked pixels;
it only moves a copy of those pixels to the new
location. It's like peeling off a copy of that part of your
image and then placing the copy elsewhere on the
image. The copy is a floating selection, so you can
move the copy as many times as you like without
changing the image underneath it.

This tool does nothing if there is no current selection.
It has no option dialog box. In addition, you can also
move the selected area without using Area Move Tool.
Please see the "Using the Keyboard" section in
Chapter 2.

Zoom Tool

Clicking the left button in the active image
window with this tool magnifies your view of
the image. This is like using a magnifying glass to get
a better look at your work; it does not change the
actual size of your image. (To change the image size,
use the Resample command in the Transform menu.)

You can see the current magnification ratio in the
status bar at the bottom of the screen; magnification
of 1:1 is 100% (normal size), 2:1 is 200%, 3:1 is
300%, and so on.

To shrink the image, simply click with the right button
in the active image window. 1:2 is 50%, 1.3 is 33%,
1:4 is 25%, and so on.

You can make your view as large as 18:1 or as small
as 1:16.

Double-clicking on the zoom tool button sets the
viewing ratio of the current image to 1:1.

i) Grabber Tool
To adjust the position of your image in the

image window, click on your image with the
Grabber Tool and drag in the direction you want your
image to move. For example, if your image is very
large and you can only see half of it at a time, you can
use this tocl to move it and look at the other hali. It's
more convenient than clicking on the image window
scroll bars because you can use it to move at any
angle with one quick mouse movement.

If you have trouble getting the hang of dragging your
image (n the right direction, try thinking of your image




as a large canvas hanging outside your little bathroom
window. (The canvas is your image, and the window
is the image window.) Imagine that clicking on the
image is the act of grabbing the canvas. Then you
drag the canvas in the direction you want it to move.

This does not affect your image in any way: it only
adjusts your view of the image.

Double-clicking on the Grabber Too! button has no
effect.

Text Tool

The Text Too! aliows you to add a line of text on
the active image. To use it, click the tool on the
location where you want the text to start. Since text
you create with this tool flows from left to right, you
should click at the top left corner of the area where
you want the text to appear.

When you click, the text dialog box appears for you to
enter your text. Type the text you want in the main
dialog box area. Note that pressing return will have
the same effect as clicking on the OK button.

You can aiso click on the "Font" button to get the
Select Font dialog box, which allows you to change
the font and add various styles and effects. Changes
you make in the Select Font dialog box will be applied
to all of the text in the text dialog box.
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Options in the Text Tool dialog box:
Double-clicking on the Text Tool button shows up the
Select Font dialog box, and allows you to designate
the default font settings for your text.

Stamp Tool

The Stamp Tool allows you to lay down a
predefined shape on your image with every
click and drag of your mouse. If you do not set it to
something else, the Stamp Tool creates rectangles
and fills them with the active color at 0% transparency
(opaque). To use it, click and drag in your image to
create the rectangle, just like you would do with the
Rectangle Select Tool if you were making a
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rectangular selection. If you don't like the result, use
the Trash Can Tool to discard the stamp.

You can define your own stamps, too. To do this,
create a new 8-bit Grayscale image of the same
proportions that you want the stamp to have. Draw
your stamp in white on a black background. (If you
want your stamp to have holes in it, draw them in
black.) Then convert the image to 1-bit Black-and-
White format and save it as a .BMP file in the
"STAMPS" sub-directory of the PhotoStudio program
directory. Quit PhotoStudio and change the files
extension from .BMP to .STM (use the Rename
command) so that PhotoStudio will know it is a stamp
file. When you run PhotoStudio again, the new stamp
name will appear in the list with the other predefined
stamps in the Stamp Option dialog box. (Refer to the
Options discussed below.)

The Stamp Tool has many options you can access by
double-clicking on the tool button.

Options in the Stamp Tool

dialog box:

Source - This list contains a library
of predefined shapes like ellipse,
line, frame, arrow, and star. If you
pick one of these shapes, the tool
will create that shape until you
change your selection again, or
until you quit PhotoStudio.

Transparency - Changes the transparency of the
stamps made by the tool, from 0% (opaque) to 99%
(so transparent you can barely tell that you made a
stamp).

Draw From Center - Like the Rectangle Select Tool
option, this option makes the Stamp Tool create
stamps from the center outward. In other words, when
you click and drag to create a stamp, the click
defines the center of the stamp instead of the upper
left corner.

Default Size - If this option is turned on, simply
clicking with the Stamp Tool will create a stamp of a
predefined size. If the Draw From Center option is on,
the new stamp will be centered at the location where
you clicked; if not, it will be located below and to the
right of the place where you clicked. The default size
varies depending on the current Source selection.

Gradient Fill Tool
This tool fills the current selection or the entire
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active image with a gradient from the alternative to the
active color. A gradient is a transition from one color
to another, like the transitions you see between
orange and blue near the horizon during a sunset.

To use it, click at the point where you want the
gradient to begin and drag to designate the length
and direction of the transition. For example, if you
want a gradual, sunset-like gradient, set your
alternative color to a sky blue and your active color to
a deep orange. Then click at the top of your image
and drag straight down to the bottom. If you drag for
a shorter distance, the transition will occur more
quickly. Also, you can have part of the transition occur
outside of the current mask or image by dragging
past the boundary of the mask or image.

By default, gradients are opaque (0% transparency),
but you can change this by double-clicking on the
tool button and changing the options.

Options in the Gradient Fill
Tool dialog box:

Color Model — Ordinarily,
gradients are made in the
RGB scale. HSV makes the
gradient transition happen in
the HSV color scale; the end
result is a rainbow-like
transition between the colors.

Rectangle Select Optiun

Transition — Allows you to opt for a harsher transition.

Transparency — Allows you to change the
transparency of the gradient.

Color Sweep — Allows you to choose multipie
gradients. If this is set to 3, for example, the transition
you want will occur between the alternative and active
col ors. However, right after changing to the active
color, it will transition right back to the alternative
color, and then back to the aclive color once again,
for a total of three bands of changing colors.

Gradient Style — Ordinarily, this is set to linear, for a
line-by-line gradient style. You can change the shape
of the gradients to be circular, elliptical, square, or
rectangular.

Bucket Fill Tool

The Bucket Fill Tool selects an area based on
color similarity and adds the active color 1o it.
It's like the Magic Wand Tool (see Magic Wand Tool),
except that after it makes the selection, it fills the
selected area with the active color. To use it, click on

the area where you want to add the active color.

Of course, you can change its characteristics by
double-clicking on the tool button and altering the
options.

Options in the Bucket Fill Tool
dialog box:

Transparency — Changes the
transparency of the active color that
is added by the tool.

Color Similarity — Like the Magic
Wand Tool, the Bucket Fill Tool's similarity option
allows you to make the tool affect more or affect less
of the contiguous area where you have clicked.
Setting this to a higher number means that the tool will
affect more of your image. However, unlike the Magic
Wand Tool's similarity option, you cannot separate the
red, green, and blue spectrums. Your similarity setting
is the same for all three,

Airbrush Tool

This tool simulates the effect of an artist's

airbrush, slowly adding layers of the current
active color on top of areas where you click and drag.
For a stronger effect, drag back and forth over the
area several times. If the shape of the airbrush effect
is not to your liking, change it using the Show Brush
Palette command from the View menu.

If you want the color to appear more slowly or more
transparently, you can change the rate of application
or transparency by double-clicking on the tool button
and changing the options.

el Options in the Airbrush Tool
dialog box:

Transparency — Changes the
transparency of the color that is
added by the Airbrush (0% being
opaque).

Rate of Flow - Ordinarity, this is
set to 100%. If you want to moderate the speed at
which the active color is added by the Airbrush, lower
this setting.

Paintbrush Tool

This tool applies a thick, opague layer of the

active color to the area where you click and
drag. (You can make the “paint” more transparent by
changing the options.) Like a real paintbrush, the
color applied by the tool fades somewhat when you
drag more quickly. Unlike a real paintbrush, the tool




never runs dry; moving the mouse slowly will always
create the richest color allowed by the current
settings.

Like the Airbrush Tool, the Paintbrush’s settings can
be customized by changing the options and/or
altering the brush shape using the Show Brush Palette
command from the View menu.

When you double-click on the Paintbrush Tool button,
a dialog box will appear for more options. Click OK to
activate your setting.

Options in the Paintbrush Tool
dialog box:

Transparency — Changes the
transparency of the color that is

. added by the paintbrush (0% being
o Fr opague).

Rate of Flow — Ordinarily, this is set to 100%. If you

want to moderate the speed at which the active color
is added by the paintbrush, lower this setting.

Smudge Tool

This tool simulates a finger smearing the “paint”
in the image. It's a directional effect; if you click
in a red area and drag into a white area, you'll end up
creating a small pink area in the white section. Going
in the opposite direction makes a pink area in the red
section. Also, if you drag faster, the effect is rougher
and not as intense.

The shape of the brush is set using the Show Brush
Palette command from the View menu.

Options in the Smudge Tool
dialog box:

Rate — This changes the intensity
of the smudge effect. A higher
setling creates a more intense
effect.

e

Smudge Option
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Pen Tool

This toot draws like a marker or felt-tip pen. In
other words, when you click and drag in the
image, it draws an opaque line that's the same color
as the active color. (You can change the transparency
in the options.) If you drag more quickly, the line
becomes less solid.

The shape of the brush is set using the Show Brush
Palette command from the View menu.
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Options in the Pen Tool dialog
box:

Transparency - Changes the
transparency of the color that is
added by the Pen (0% being
opaque).

Brighten/Darken Tool

This brightens (or darkens, depending on
settings) the area where you click and drag the
mouse. The shape of this tool can be changed using
Show Brush Palette from the View menu.

The tool cursor will change to reflect whether you are
about to brighten or darken: when brightening, the
value of Brightness is larger than zero, the cursor is
an arrow with a white star; when darkening, the value
of Brightness is negative, the cursor is an arrow with a
black star.

Pen Option
ST T

Options in the Brighten/Darken
Tool dialog box:
Brightness-Changes the effect of
this tool anywhere from 100%
(completely bright) to -100%

Brightness Option

(completely dark).

peg| Smooth/Sharpen Tool
mpl This brush-type tool has an interesting
averaging or differentiating effect in the area
where you click. It's useful for smoothing rough edges
and harsh transitions, and for sharpening areas that
seem fuzzy. Drag to affect a larger area. To get the
heaviest effect, click (and drag, if necessary) many
times in same general area.

By default, the Smooth/Sharpen Tool is set to the
smoothing function. (To change this setting, double-
click on the tool button to bring up the options dialog.)
Each time you smooth an area, PhotoStudio averages
the color of each affected pixel a little with the colors
of the pixels around it. This adds a general blur or
haze to the area and hides sharp contrasts.

For example, if you have an image of small red polka-
dots on a blue background, smoothing it would make
the edges of the dots blurry and purplish. A lot of
smoothing would make the whole area purple.

On the other hand, sharpening accentuates the
contrast between each affected pixel and its
neighbors. If it is the same color as the others but
slightly darker, sharpening makes the pixel darker and
its neighbors lighter. Too much sharpening makes




UL U UL YU O E G YD YL YUYy

your image seem grainy.

The tool’s cursor will show you whether you are about
to smooth or to sharpen. When you are in smooth
mode, the cursor is an arrow with an arc next to it;
when in sharpen mode, the arc becomes an angle.

The shape of the brush is set using the Show Brush
Palette command from the View menu.

To smooth or sharpen your entire image or selected
area, use the filters from the Enhance menu.

Options in the Smooth/Sharpen
Tool dialag box:

Tool — Switches the tool between
Smooth and Sharpen mode.

Effect — Changes the intensity of
the smoothing or sharpening

Clone Tool

This useful tool duplicates one part of your

image in another part of the image. For
example, you can give a person a third eye in the
middle of his forehead if you clone one of his existing
eyes.

To do this, you'd click with right button on the existing
eye. This tells PhotoStudic where the source of the
cloning will be; a plus sign (+) would appear at that
location for your reference. Then you'd press and
drag with the left button in the middle of his forehead.

Of course, PhotoStudio does not know exactly what
you want to clone, so dragging too wildly will deposit
a nose on your victim's left eye and an eyebrow in his
hairline. Also, each time you release the mouse button
and press it down again, you tell PhotoStudio that you
want to make another clone in the current location, so
uncontrolled clicking will create a panorama of eyes.

One of the most powerful aspects of the Clone Tool is
that you can clone between images. Just set your
source in one image, switch to the other, and clone.
You can also activate the Use Clipboard feature in the
optlions dialog. This feature lets you use the image
you have on the PhotoStudioc clipboard as the source
for your next cloning operation.

Like many other tools, the Clone tool's area of effect is
determined by the current setting in the brush palette.

When you double-click on the Clone Tool button, a
dialog box will appear for more options. Click OK to
activate your setting.

Options in the Clone Tool dialog
box:

Iransparency - Changes the
transparency of the cloned
area(s) you are planning to
create. This is set to 0% by
default.

Soft Edge — Makes the edge of the cloned area softer
for a better visual match with the existing image. This
is turned on by default.

Use Clipboard — As mentioned in the main Clone Tool
description, this feature allows you to use the current
clipboard image as the source for the next cloning
operation. If there is no image in the PhotoStudio
clipboard, this option will be unavailable. The location
of the source point is hard to determine for clipboard
cloning. since you cannot see the plus sign on the
clipboard, and you cannot define a new source point
by clicking the right mouse button on the clipboard.
The clipboard source point will be located at the
same coordinates as the last source point you used
(even if the last source point was not in the same
image as the clipboard image). If this is the first time
you have used the Clone Tool since you started
PhotoStudio, the clipboard source point will be
located at the coordinates (0,0) — that is, the very top
left-hand corner.

7 Revert Tool
This tool is like a modified eraser brush that
allows you to blend the changes you've made
to the currently masked area together with the original
state of that area (the underlying image area).

To use it, simply click and drag over the areas that
you want to blend. By default, this tool erases the
floating selection affected and restores the respective
underlying {100%). You can change this setting in the
options dialog box.

Of course, you cannot make a change, make a few
other alterations, mask the first change, and then use
this tool. It only affects changes that have been made
while the current mask has been active.

To undo all the changes you've made to the current
selection, use the Trash Can Tool.

The shape of the brush is set using the Show Brush
Palette command from the View menu.

When you double-click on the Revert Tool button, a
dialog box will appear for more options. Click OK to




activate your setting.

Options in the Revert Tool
dialog box:

Underlying - Changes the
opacity of the pixels that are
being restored from the
underlying image area. By default, this is sel to 100%.

Transform Tool
ﬁ This tool allows you to resize the current

selection. When you choose this tool from the
toolbox, your selection instantly gains four small black
squares at its four corners. (If your selection is not
rectangular, PhotoStudio puts a temporary rectangular
boundary around it and the squares appear at the
corners of this rectangle.) These are called “handles”
and they are not permanent; they disappear when the
transformation is complete. Clicking and dragging any
one of them will alfow you to resize the selection from
that side.

You can release the mouse button and resize it again
and again without the change taking effect. To restore
the original selection size, double-click outside the
selection boundaries. To trigger the actual resizing
operation, double-click within the selection. If you
start the operation and change your mind, you can
cancel it by pressing the escape key (Esc).

The new resized selection appears as a floating
selection; if you move it away with the Area Move
Tool, the underlying original image will appear
untouched.

Revert Option If you double-click on the

tool button and change
the options settings, you
can use this tool in three

.' other ways:

1} Rotate — rotates the selection around its center
point. As you drag, the amount of rotation (in degrees)
appears in the status bar for your reference.

i

2) Skew — distorts the selection horizontally or
vertically, depending on the initial direction you drag
the mouse. Visually, this effect makes your selection
look like it is leaning to one side (or up or down on
one end). Geometrically, this effect lets you give your
selection the shape of a parallelogram, and stretches
or shrinks parts of the image to match the new shape.

3) Perspective — distorts the selection in such a way
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that it gives one end (left, right, top, or bottom) the
appearance of being either in the distance or in the
foreground. Geometrically, this effect allows you to
give your selection a trapezoidal shape, and stretches
or shrinks parts of the image to match the new shape.

Repeatedly transforming your selection until you get
the result you want is not recommended, because
each transformation operation reduces the sharpness
of the selection.

Crop Tool

When you click on this tool's button, it instantly
copies the current selection from your image
and makes a new document out of it. The original
document is left untouched. For example, if you select
the sun from your landscape image and then crop, a
new, smaller image window will appear, and it will only
contain the sun. The rest of the landscape will be left
out of the new window.

This tool has no options dialog box.

Eyedropper Tool

The Eyedropper Tool makes the active color

the same as the color of the point you click
on. It also displays in the Status Line the color values
of the pixels that you move the pointer over. (As you
can guess, this makes it much easier to create
objects and shapes that match existing ones.)

Tip: The Eyedropper samples the point that's at the
very tip of the eyedropper icon in the image window.
It's easy to accidentally sample the wrong color,
especially since some areas that look solid actually
contain tiny spots of other colors. For example, an
orange flower can contain tiny spots of red and
yellow. Make sure that the active color visually

matches the color you want after you've used this tool.

If you double-click on the tool button, a dialog box will
appear for option’s setting.

Options in the
Eyedropper Tool dialog
box: RGB and HSV
Switches the color value
display between RGB and
HSV scales.

Trash Can Tool

Clicking on this tool's button instantly removes
the current mask and all changes that have
been made in it. If you are about to try some
experimentation on your image, it's often handy to
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mask everything first so you can undo the changes
made within the selection if necessary.

Of course, you cannot make a change, make a few
other alterations, mask the first change, and then use
this tool. It only affects changes that have been made
while the current mask has been active.

This tool has no options dialog box.

= Color Swatches
The color swatches at the bottom of the

— toolbox are convenient indicators of your
current active and alternative color selections. The
active colfor is the color that is applied to your image
by the various brush tools, and it is used by other
functions and tools as well. It is also the color that
appears in the place of your selection after you
perform a Cut command from the Edit menu. The
alternative color helps to determine the effect you get

with the Gradient Tool, and it is handy as an "on deck”

color because you can make it into the active color
merely by clicking on its swatch.

If you move the mouse pointer over the color
swatches, the status bar will show you what they are
and their respective color values.

To change the alternative color, click on it to make it
the active color, change the active color, and then
switch back to the original active color.

There are three ways to change the active color:

1) Use the Eyedropper Tool (Please refer to the
Eyedropper Tool in Chapter 4). This is the best
method for getting the active color to match a color in
your image.

2} Use the Color Palette (Please see the Color Palette
in Chapter 4). This is a quick way to pick from the
range of colors available in PhotoStudio.

3) Double-click on the Active Color Swatch to bring
up the Color Selection dialog box. This is the best
method when you want to use the HSV color system
to choose a color, or when you find the Color Palette's
selections to be too imprecise.

The Color Selection Dialog Box:

This dialog box gives you many color selection
options, including two different color systems: RGB
and HSV.

When the dialog box first appears, it is in RGB color
mode with the red spectrum selected. This is
indicated by the button next to the R in the top right-
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hand corner. If you know the RGB color values of the
color you want to select, simply enter them into the R,
G, and B value boxes at the top right. Then click the

OK button to make that your active color.

If you want to switch to the HSV color system, just
click on the button next to the H, S, or V at the right. If
you have specific HSV values, you can enter them in
the value boxes at this time.

The sliding scale at the top of
the dialog box and the field
below it provide a good two-
part system for in-depth color
selection. The button that is
clicked nextto the R, G, B, H,
S, or V on the top right-hand

TE side indicates the color
characteristic you are currently examining. The scale
always shows the range of possible values for that
characteristic. For example, if the R button is currently
selected, the slider shows a range from black (no red)
to bright red. Clicking at different spots on the scale
changes the amount of red in the current color
selection and in the field.

The field shows all the possible colors you could
choose if you were to keep the current red value and
vary the other two values (green and blue). If the G
button were currently selected, the field would show
varying levels of red and blue; if the H button were
selected, the field would show varying levels of
saturation and brightness.

Using the sliding scale to isolate the most important
color characteristic and the field to pick from the
resulting possibilities should make it easy for you to
find the color you want.

For your reference, the Old color patch shows the
active color and the New color patch shows the color
selection you've made in this dialog box.

Of course, if your monitor or video card cannot
display 24-bit color, this dialog box cannot show the
full range of possible colors. PhotoStudio will arrange
the avallable colors in such a way that you can get a
good general idea of how the colors would look if you
had 24-bit color.

Tip: If you are simply browsing for a color, it's offen
helpful to click on the H button to see the hues
displayed like a rainbow in the sliding scale. You can
click on the hue you want and then pick out your color
from the large field below the scale.




